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To fully utilize the features and capabilities of TopDog, we suggest that you spend a few 
minutes reading the chapters in this guide. However, for those users who wish to get started 
immediately we offer the following Quick Start Guide to TopDog.

Overview

TopDog's exclusive search and submit technology works by first searching the search 
engines for your web site to determine precisely where (or if) your site appears in the 
listings. Once searching is completed, TopDog then optionally submits, or registers, your 
web site with those search engines on which it is not listed, or not listed well. 

TopDog will resubmit your web site as necessary, making continued use of it to 
automatically monitor and maintain proper placement both easy and convenient.

TopDog stores everything about a web site, including submission history and category 
selections for search engines, in a single project file. Because TopDog won't clutter 
your hard drive with hundreds of files for each project, it's easy to store, organize, and 
share data for multiple projects or computers. There is no limit on the number of 
projects or web sites you can create.

To get started, you must create a project for your web site, enter details about it, then 
execute and save it for future re-use.

It's as easy as 1, 2, 3 . . .

Step 1 - Create a new project

If TopDog is not already started, start it by double-clicking the TopDog icon on the 
desktop. From the main menu, select File|New to start a new project, or click <New> 
from the toolbar.

Step 2 - Enter the URL Addresses and Search Terms for your web site



Enter the URL address of your web site (e.g., www.yourdomain.com). Optionally, enter 
any additional text that specifically describes your site such as your company name or 
product name. TopDog will scan the results from each search engine for the values 
entered here when determining if a match is found. In the Search Terms field, enter 
words or phrases that a person would normally use to query a search engine for your 
product or service. These are the search terms that TopDog will pass down to the search 
engines when performing a search. Do not enter all of your meta tag keywords here.

Step 3 - Select the search engines with which you wish to work

From the main menu, select Project|Select Search Engines, or click <Select> from 
the toolbar. You can set or remove checkmarks beside each search engine you wish to 
include in your project. You may also use the "Select By" button to group-select search 
engines by category, language, country, or submittable status.

Step 4 - Enter details of your web site for submission



Project Properties - Submit Info Tab

From the main menu, select Project|Properties... to open the project Properties dialog 
box, or click <Properties> from the toolbar. Now select the Submit Info tab, if it's not 
already selected. Fill in any relevant information for the search engines you selected. 
See Submit Info for more information on entering information into this dialog box. It is 
usually wise to fill in all fields in this dialog box. That way TopDog will be able to submit 
to any search engines it supports.

Step 5 - Specify the rules for submitting your web site



Project Properties - Submit Rules Tab

From the main menu, select Project|Properties... to open the project Properties dialog 
box, or click <Properties> from the toolbar. If the dialog box is already open, select the 
Submit Rules tab if it's not already selected. Check the box labeled Automatically 
submit to a search engine when finished searching and it meets the submittal rules 
below. This will allow TopDog to submit to the search engines after it has completed a 
search for that search engine. See Submit Rules for more information on making 
selections in this dialog box.

Once your site has been submitted to a search engine, TopDog will not re-submit it until 
the time specified in Limit Submittal has passed. Most search engines take 2-8 weeks 
to process submission requests, so this feature prevents your site from being 
resubmitted unnecessarily each time a search is performed.

Step 6 - Initiate the search and view the results

From the main menu, select Search|Search All to start the search, or click <Search 
All> from the toolbar. Because the "automatic submission" feature was enabled in step 
5, you should not use the Submit|Submit All option in the main menu.

To cancel a search in progress, select Search|Stop from the main menu, or click 



<Stop> in the toolbar. Results and progress messages for each search engine are 
displayed in real time in the Search Engine List view. 

If you enabled "automatic submission" in step 5, TopDog will first search all the search 
engines for your search terms, then process submissions after all the searches have 
completed. This "search and submit" technology allows TopDog to avoid resubmitting 
your site to search engines for which your site already has good placement.

If a submission fails for any reason, right-click on it and choose Show Last Submission 
Results to see the actual page returned from the submission process.

To see the results of a project run, double-click on any search engine to view a Details 
report, or right-click for more options. You may also view the submission history using 
the Reports | Submission Summary Report option.



Using "What's This?" Help

Microsoft Windows comes with a helpful feature they refer to as "What's This?" help. I call it 
the "Question mark Help" because that is what it looks like on the screen. If you look in the 
upper right-hand corner of most dialog boxes in TopDog, you will find a small question mark 
to the left of the 'X' button -- you know, the one that closes the dialog box. Below is a 
sample, taken from the corner of a dialog box, of what I am talking about.

When you click this button with your mouse, the button stays pushed in and the mouse 
cursor changes to a cursor with a large black question mark to the right. (Yours may be 
different if you have loaded a custom set of cursors.) This is your clue that question mark 
help is active. Now using your mouse, you can click on most elements in the dialog box for 
more information. This is very useful when first learning a program like TopDog. 

Go ahead and give it a try yourself. Open the Select Search Engines dialog box by clicking 
the Select button on the toolbar. You'll notice that the question mark help is available from 
this dialog box. Click the question mark in the upper right-hand corner of the dialog box. 
Your cursor should change to one with a question mark to the right of the arrow. Now click 
on an element in the dialog box. If the Search Engines tab is showing, click on the list of 
search engines. This is what you should see.

Loaded with this new information, you should be up and using TopDog like a pro in no time. 
Try this in other programs too. You'll be surprised what you can learn about a program from 
the question mark help.



Software License

LICENSE AGREEMENT FOR TOPDOG SOFTWARE

IMPORTANT READ CAREFULLY: This agreement is a legal agreement between you (either an 
individual or a single entity) and DC Micro Development, Inc. (DCMD) for the TopDog 
software identified above, which includes computer software and associated media, and may 
include online or electronic documentation. By installing, copying, or otherwise using the 
software, you agree to be bound by the terms of this agreement.    If you do not agree to 
the terms of this agreement, please do not install or otherwise use the software.

The software is protected by copyright laws and international copyright treaties, as well as 
other intellectual property laws and treaties. The software is licensed, not sold.

DCMD grants to you a non-exclusive, limited license to use the software, pursuant to the 
terms hereof. DCMD provides the license solely for end-user use. You may not reverse 
engineer, decompile, or disassemble the software. The software is licensed as a single 
product. Its component parts may not be separated for use on more than one computer. You 
may not rent or lease the software. You may make copies of the software and transfer your 
rights under this agreement, provided that each recipient of the software also agrees to the 
terms of    this agreement.

Without prejudice to any other rights, DCMD may, in its sole discretion and at any time, 
terminate this license.    In such event, you must destroy all copies of the software and all of 
its component parts.

All title and copyrights in and to the software (including but not limited to any images, 
photographs, animations, video, audio, music, text, and applets, incorporated into the 
software), and any copies of the software are owned by DCMD (or one or more of its 
licensors). The software is protected by copyright laws and international    treaty provisions. 
Therefore, you must treat the software like any other copyrighted material except that you 
may make copies of the software, subject to the limitations set forth herein.

NO WARRANTY; LIMITATION OF LIABILITY

(a) THE SOFTWARE IS PROVIDED "AS IS," AND NEITHER DCMD NOR ANY OF ITS 
LICENSORS MAKES ANY EXPRESS OR IMPLIED REPRESENTATIONS OR WARRANTIES TO 
YOU REGARDING THE USABILITY, CONDITION OR OPERATION THEREOF.    NEITHER DCMD 
NOR ANY OF ITS LICENSORS WARRANTS THAT THE SOFTWARE WILL MEET ANY 
PARTICULAR CRITERIA OF PERFORMANCE OR QUALITY.    DCMD AND ITS LICENSORS 
EXPRESSLY DISCLAIM ALL IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION, 
WARRANTIES OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE, NON-
INFRINGEMENT, COMPATIBILITY, SECURITY OR ACCURACY.

(b) YOUR USE OF THE SOFTWARE IS AT YOUR OWN RISK.    YOU ASSUME FULL 
RESPONSIBILITY AND RISK OF LOSS RESULTING FROM YOUR DOWNLOADING, 
INSTALLING, AND/OR USE OF FILES OR OTHER MATERIAL.    YOU AGREE THAT NEITHER 
DCMD NOR ANY OF ITS LICENSORS WILL BE LIABLE FOR DAMAGES (INCLUDING 
CONSEQUENTIAL OR SPECIAL DAMAGES) ARISING OUT OF YOUR USE OF OR INABILITY TO 
USE THE SOFTWARE, AND YOU HEREBY WAIVE ANY CLAIMS WITH RESPECT THERETO, 
WHETHER BASED ON CONTRACTUAL, TORT OR OTHER GROUNDS, EVEN IF DCMD (OR ANY 
SUCH LICENSOR) HAS BEEN ADVISED OF THE POSSIBILITY OF DAMAGES.    THE ENTIRE 
LIABILITY OF DCMD AND ITS LICENSORS, AND YOUR EXCLUSIVE REMEDY WITH RESPECT 



TO THE USE OF THE SOFTWARE OR ANY BREACH OF THIS AGREEMENT, SHALL BE THE 
REPLACEMENT OF ANY SOFTWARE FOUND TO BE DEFECTIVE.    YOU HEREBY RELEASE 
DCMD AND ITS LICENSORS FROM ANY AND ALL OBLIGATIONS, LIABILITIES AND CLAIMS 
IN EXCESS OF THIS LIMITATION.    SOME JURISDICTIONS DO NOT ALLOW IMPLIED 
WARRANTIES TO BE EXCLUDED OR MODIFIED OR LIABILITY TO BE LIMITED, SO NOT ALL 
OF THE ABOVE LIMITATIONS MAY APPLY TO YOU.

(c) NEITHER DCMD NOR ANY OF ITS LICENSORS SHALL BE HELD RESPONSIBLE IN ANY 
WAY OR BY ANY MEANS, EITHER DIRECTLY OR INDIRECTLY, FOR ANY COMMUNICATIONS 
DIFFICULTIES OUTSIDE OF DCMD'S CONTROL WHICH COULD LEAD TO THE INTERRUPTION 
OF DATA DELIVERY SERVICE TO YOUR ELECTRONIC MAIL ADDRESS, PAGER, TELEPHONE 
OR ANY OTHER RECEIVING DEVICES OR THIRD-PARTY DATA STORAGE AND/OR DELIVERY 
SERVICES.

(d) IN PARTICULAR, YOU WILL NOT RELY ON ANY REPRESENTATION OR WARRANTY, 
EXPRESSED OR IMPLIED, MADE BY ANY PERSON OTHER THAN AN AUTHORIZED OFFICER 
OF DCMD, IN EVALUATING THE SOFTWARE..

If any part of this agreement is held invalid or unenforceable, that portion shall be 
construed to reflect the parties' original intent, and the remaining portions remain in full 
force and effect. The laws of the State of California, excluding its conflicts-of-law rules, 
govern this agreement and your use of the software, and you expressly agree that exclusive 
jurisdiction for any claim or dispute arising from the use of the software resides in the 
courts of the State of Georgia. 



How to Purchase

Purchasing TopDog (and our other products) is fast and easy. Simply download 
the software and activate it online with a credit card, or obtain an unlock code 
from a sales representative over the phone.

TopDog for Windows 95/98/NT
U.S. $179, including one year of free Instant Update™ software updates.

TopDog LE for Windows 95/98/NT Upgrade
U.S. $129, including one year of free Instant Update™ software updates. (You must already 
own a copy of TopDog LE to upgrade.)

Web Site Strategies: Search Engine Ranking and Optimization
U.S. $19.95, a special report filled with dozens of useful ideas, tips, and pointers to make 
your web site search engine friendly.

Annual Maintenance
U.S. $59
Extends Instant Update™ software updates for a full year.
U.S. $99
Extends Instant Update™ software updates for a full 2 years (you save $19).

We accept VISA, MasterCard, American Express, and Discover credit cards. 

Three Easy Ways to Order

1. Use our Secure Online Purchase System
Click here to instantly purchase TopDog with your credit card. No waiting!

2. Order Online Using a Credit Card and Internet Connection
First download and run the software, then click the Purchase TopDog option on the Help 
menu to use TopDog's integrated secure ordering feature. No waiting!

3. Order Directly From a Sales Representative
Call our toll-free number (see below). A sales representative will charge your credit card 
and issue an authorization code, which can be used to unlock the demo. You can also fax 



your order to us.

Questions? Ready to purchase? Call our sales team!

800-775-1073 toll-free
678-442-1623 outside the U.S.
678-442-1819 fax
http://www.topdog2000.com
sales@topdog2000.com



Upgrading TopDog LE

TopDog LE is a special edition of our award-winning TopDog Search Engine Analyzer 
Submitter, but with a low $49.99 retail price. TopDog LE is sold only through stores as: Web 
Traffic Maximizer by Macmillan Computer Publishing, Inc. and is available nationwide at 
Best Buy, Staples, Office Depot, CompUSA and other retailers. 

TopDog LE is identical to the full version of TopDog with the following exceptions: 
· The full version supports many more search engines: 240 in all (as of this writing -- the 

number is increasing every week), including all the top engines in the U.S. and Europe.
· The full version allows customization of the reports to include your company information.

TopDog LE can be upgraded over the internet to the full version for the $129 price 
difference. Plus, we'll send you a free copy of our new, special report, "Web Site Strategies: 
Search Engine Ranking and Optimization," which offers dozens of useful tips to make your 
web site search engine friendly.

To upgrade your copy of TopDog LE for just $129 (a savings of $50 off the retail price), see 
How to Purchase.



How TopDog Works

TopDog works just like you would work using a regular web browser, but much faster.

Searching

The goal of the searching algorithms is to produce a report informing you of the precise 
ranking of your web site in the search engine listings for any number of Search Terms.

TopDog visits the starting page of each search engine, enters your search terms, then 
parses the listings produced by the search engine (up to an adjustable, default depth of 50 
results) into distinct entries and stores them in your project database. Each listing includes 
two elements -- the document URL and it's descriptive text.

The software then performs a "smart" scan of each listing, in it's entirety, for the value 
you entered in the URL field. TopDog automatically compensates for variations in the 
presence or absence of prefixes such as "http://", "http://www.", "www.", etc., and it will 
not be fooled by partial matches or by listings which contain your own URL as part of 
another URL. There is an option (see Tools | Options | Searching) to cause TopDog to limit 
scanning to the actual document URL of each listing, which is sometimes useful to avoid 
false-positives for listings which aren't your own but which include a reference to your URL 
in their descriptions.

TopDog repeats this process for every search engine, running separate searches for each 
Search Term you entered.

Submission

After searching is completed for all your search terms on all the selected search engines, 
TopDog will evaluate the ranking information and previous submission history to determine 
if submission should be attempted. By default, TopDog will skip submission to a particular 
search engine if any of the following conditions are true:

· It's been less than one month since the last successful submission (this is an 
adjustable default value), or

· Any of the search terms produced a ranking within the top 10 positions (this is an 
adjustable default value), or

· Your site is not eligible for submission to the particular search engine (e.g., TopDog will 
not submit sites classified as "Adult" to family-oriented search engines).

Otherwise, TopDog will attempt to submit your web site to each search engine by visiting 
the starting page, locating the "add url" page, and filling in and submitting the form fields 
on the subsequent pages using data you provided about your web site (see Project | 
Properties). TopDog then stores the page returned by the search engine in your project 
database and examines it for the expected response. If the page indicates a successful 
submission, TopDog marks the result and records the date. All of this information is 
accessible via the Submission Summary Report in the Reports menu.

You can see the page returned by the submission process by right-clicking on a search 
engine in TopDog and selecting "Show Last Submission Results".



Web Resources

TopDog's web site, http://www.topdog2000.com, contains lots of up-to-date information 
that you won't find in the help file. For this reason, we provide quick links to those areas of 
interest.

What's New

This is where you will find the latest information about TopDog. This includes new 
features, repaired search engines, bug fixes, and what the latest version of TopDog is. If 
you haven't been running TopDog in a while, come here to see what you've been 
missing.

Features

If you ever wondered what TopDog can do, come here. TopDog has more features than 
any other competitor on the market today. Features is a comprehensive list of what 
TopDog can do. As TopDog evolves this list will grow, so keep an eye on this one.

Frequently Asked Questions

Come here if you have a question about TopDog. We update the FAQ with questions our 
users have posted that we think might be relevant to all users. Including users of the 
demo/shareware version.

Search Engine Tips

If we find any information about the search engines that can help you in gaining better 
placement, we will usually post it here. This is where we keep little know tid-bits about 
some of the major search engines.



System Requirements

TopDog requires the following:

PC running Windows 95, 98, Me, NT, or Windows 2000
16MB of RAM (32MB recommended)
5MB of disk space
An Internet connection (any ISP, dialup, cable-modem, or network)



Installing TopDog

Installing TopDog is easy and straightforward. 

DOWNLOAD
If you downloaded a copy of TopDog from the web site (http://www.topdog2000.com), just 
run the TopDogSetup.exe you downloaded and follow the directions on screen.

FLOPPY DISKS
If you received TopDog on floppy disks, just run the SETUP.EXE installation program from 
the first disk. 

CD-ROM
If you received TopDog on a CD-ROM, it should start the install automatically when the CD 
is inserted into the drive -- unless you have that feature disabled in Windows. If you do, just 
run the SETUP.EXE installation program manually from the root directory of the CD-ROM. 

WEB TRAFFIC MAXIMIZER (TopDog LE)
Follow the onscreen directions for installing TopDog LE from the Web Traffic Maximizer CD-
ROM. After TopDog LE is installed, fill in the registration information and click OK. You 
should be presented with a Purchase dialog, click the <Purchase> button. Next enter the 
10-digit code affixed to the CD-ROM sleeve in the Authorization Code field and click OK.



Software Updates

TopDog's Instant UpdateTM technology automatically delivers all 
updates to you over the internet.

From time to time, search engine companies change the layout of their systems, which can 
cause other web positioning software to fail. However, TopDog's Instant Update™ 
technology and object-oriented architecture allow automatic updates of its features and 
support for new search engines to be added or updated continually.

One Year of Free Updates
Software updates are provided free to all registered users for a period of one year. After 
that, you must purchase an annual subscription update, which ensures that your investment 
remains solid as search engines change their interfaces and support for new search engines 
is added to TopDog.

Instant Updates
Each time TopDog is run, it automatically checks our servers over the internet for software 
updates, providing users the option to download and install them with ease. Only one such 
automatic check is made per day, though users can invoke the feature manually at any time 
using Check for TopDog Update... from the Help menu.



Uninstalling TopDog

TopDog conforms to Windows guidelines for application installation and removal. To uninstall 
TopDog from your system:

1. From the Window's task bar, click <Start>, then choose Settings|Control Panel; 
the Control Panel explorer will display.

2. Double-click the Add/Remove Programs icon; the Add/Remove Programs Properties 
dialog box will display.

3. In the software list box, select "TopDog" and then click the <Add/Remove...> 
button. The Confirm File Deletion dialog box will display.

4. Click <Yes> to remove TopDog from your computer completely.

The TopDog install directory will remain behind. This is because your license file was created 
after the install (demo users too), plus their may be projects left behind in the TopDog 
directory. To completely remove TopDog, you will need to delete these last files manually. 



Overview

The TopDog program is composed of four main areas as shown in the screen shot below. 
The menu and toolbar, the search form, the search engine list, and the status bar.

1. Menu/Toolbar
The menu and toolbar are positioned along the top of the program window. These areas 
provide options for creating, loading, and saving projects, initiating and canceling search 
and submission operations, printing reports, and configuring program options.

2. Search Form
TopDog is designed to automate the job that a person would normally do of visiting a search 
engine, entering search terms, and browsing the results. The Search Terms text box is what 
TopDog uses to query search engines. Any text supplied in the URL Addresses text box 
(such as your web site URL, company name, or product name) will be matched against the 
results returned by each search engine to determine ranking and position. This ranking can 
also be used when submitting to the search engines automatically. For more information, 
see Search Form in this help file.

3. Search Engine List



The search engine list provides detailed information about each of the search engines 
TopDog supports. Right-clicking on any search engine row brings up a popup menu offering 
several options, such as viewing reports, starting individual searches, submitting to a search 
engine, or jumping to the home page of the selected search engine. For more information, 
see Search Engine List in this help file.

4. Status Bar
The status bar provides feedback for the current project file. Hold your mouse cursor over a 
box in the status for a tip on its contents. The calendar icon can be double-clicked to show 
the last date and time a search was ran on. Double-clicking the engines showing text will 
display a dialog box giving more details about the current project. For more information, see 
Status Bar in this help file.



File

The TopDog File menu is depicted below:

The File menu is where you work with project files, otherwise known as dog files. Projects 
are used to save search parameters and search results. Saved search results can be used in 
subsequent searches for comparisons.

New
Starts a new project. The Search Form is cleared and the search engine list is reset. Any 
results from a prior search are discarded.

Open...
Opens a previously saved project (dog file). You can also use the 'Most Recently Used' 
(MRU) file list between the Export and Exit menu options to open a previous project file. 
Furthermore, the Open button on the toolbar also supports a MRU list. To use the MRU list 
on the Open button, click the down-arrow to the right of the Open button. This drops down 
the MRU list.

Drag and Drop
TopDog also supports drag and drop. To use it, simply drag any TopDog project file from 
the Windows Explorer over the TopDog application and release the mouse button. The 
project file will be opened immediately. Alternatively, you can double-click project files, 
which will open TopDog and load the project file for you.

Save and Save As...
Saves the active project to a dog file. The Search Form and the Search Engine List are 
saved to the project file, including any results gathered from the last search. The date and 
time the search was run is also stored in the project file.

Send...
Send the active project as a dog file via email. You must have an email program installed, 
such as Outlook or Eudora, and Simple MAPI enabled for this option to be available. If you 
project is large (i.e., you are both searching and submitting and using most of the search 
engines) and you are on a dial-up connection, it may take a while to send the project file. 
Most project files are from 1K up to about 1.2MB in size. A project that uses ALL of the 
available search engines will take up about 1.2MB of disk space.

Export
Exports the active project file to one of the supported formats.



· Comma Separated Values. Importable by most spread sheet and database programs.



Project

The TopDog Project menu is depicted below:

The Project menu is where you work with settings for project files, otherwise known as dog 
files. Projects are used to save search and submit parameters and results. Saved search 
results can be used in subsequent searches for comparisons.

Select Search Engines...
This options displays a dialog box that allows you to select only the search engines that you 
are interested in when searching. For example, you may only be interested in the Top 10 
search engines for your country. This option allows you to select those engines for searching 
and submitting. Furthermore, you can save search engines selections in this dialog box as 
templates for later use in other projects.

Properties...
Sets the properties for the active project file. Any settings made here are saved with the 
active project file.

· Submit Info. Edits the submission information needed by the search engines.
· Submit Rules. Sets up the rules TopDog will follow when submitting your web site.
· Email. Sets up the default email to account for emailed reports.
· Output. Changes the default output directory for reports and exports.



Search

The Search menu is depicted below:

The Search menu is where you start and stop searches for all of the selected search 
engines. Once you have your search criteria set in the Search Form, come here to start the 
search. After the search is started, you can cancel it from here also.

Search All
Search All starts a new search. Any results from the previous search are first analyzed and 
then saved before the results are cleared for the new search. This allows TopDog to do 
comparisons against previous searches. The Search Engine List is cleared and the status bar 
is reset. The Search Engine List updates dynamically as the search is in progress. There is 
no need to wait to see the results of finished searches while other searches are still going. 
You can even run the Details report on search engines that have completed while other 
search engines are still working.

Search Selected
Search Selected starts a search on the selected search engine in the Search Engine list. The 
results from the previous search are first analyzed and then saved before the results for this 
search engine are cleared. This allows TopDog to do comparisons against each previous 
search.

Stop
This feature stops any searches in progress. Depending on your connection speed and the 
response time from the search engines, stopping the searches in progress can take a few 
seconds. During this time most functions in TopDog are disabled.



Submit

The Submit menu is depicted below:

The Submit menu is where you start and stop submittals for all of the selected search 
engines. Submission from this menu does no Submit Rules evaluations at this time. To do 
intelligent submissions, you must perform a search with the Autosubmit feature turned on. 
See the Submit Rules dialog box for more information.

 

NOTE:    Submission is a powerful feature. Used wisely, it can improve the ranking of your 
web site. Abuse it, and it can harm your web site. Please do not submit often to the search 
engines. Be patient, it can take a while for your web site to show up on the search engines. 
Some search engines can take as long as nine months to get around to your web site. This 
doesn't mean they have forgotten about you, it just means they haven't gotten to indexing 
your web site yet or it isn't showing up for the keywords you expected. Click here for more 
details.

 

Submit All
Submit All starts a new submission for all of the selected search engines. This submission is 
what we term a "blind submission". No submission rules are evaluated before the 
submission. Because of this fact, Submit All can actually harm your web site's position if 
used incorrectly. For new web sites that haven't been visible to the search engines very 
long, this is probably a good choice for first submission. If your web site has been around a 
while, autosubmission is the preferred choice.

Submit Selected
Submit Selected starts a new submission for the selected search engine. Like Submit All, 
Submit Selected does not evaluate submission rules. This is a much safer option to use 
when submitting to search engines manually. You can use your own personal judgment 
when submitting to the search engine.

Stop
This feature stops any submission in progress. Depending on your connection speed and the 
response time from the search engines, stopping the submission in progress can take a few 
seconds. During this time most functions in TopDog are disabled.



Reports

The Reports menu is depicted below:

The Reports menu is where you go to run Details and Summary reports on the active 
project file. The reports can be run while a search is in progress, although the information 
may not be complete until the search is finished. You can also email the Summary and other 
reports from here, although there is a button on the toolbar to make this easier for the 
Summary report.

If you are running a project that has multiple sets of keywords, all of the reports below 
change their format slightly to accommodate the additional keywords.

Details
The Details report contains the following information:

· Project Name. This is the name of the project file without the path information.
· Run Date. This is the date and time that this search was started.
· Performed For. This is the information entered into the URL Addresses field on the 

Search Form.
· Keywords. This is the information entered into the Keywords field on the Search 

Form.
· Pages and Results. This is the number of pages retrieved from the search engine 

and how many results were returned within those pages.
· Results. These are the actual results returned by the search engine. If your web site 

was listed, a link will be provided at the top of the report. Any results matching your 
web site will be highlighted in yellow.

Summary
The Summary report contains the following information:

· Project Name. This is the name of the project file without the path information.
· Run Date. This is the date and time that this search was started.
· Performed For. This is the information entered into the URL Addresses field on the 

Search Form.
· Keywords. This is the information entered into the Keywords field on the Search 

Form.
· Statistics. First you are told how many search engines you were TopDog on, then a 

summary of how your site was listed on the search engines follows. 
· How many search engines listed you at all.
· How many were you in the top 10.
· How many were you in the top 20 (11 to 20).



· How many were you in the top 30 (21 to 30).
· Score. This is your ranking among the search engines converted to a score for 

comparison purposes. The values are extremely useful for determining the overall 
position of your web site at a glance, and your goal as a webmaster is to get both 
values as close to 100 as possible.

· Your average ranking on the search engines that listed your site. The maximum 
possible score up to 100, with 100 indicating TopDog on every search engine that 
listed your site.

· Your average ranking for all of the search engines. Again, the maximum possible 
score is 100, which would mean that your site had the number one ranking on 
every search engine.

· Search Engine Summary. This is the Search Engine list from TopDog. If an engine 
has been disabled in TopDog, it will not show up on this report. Furthermore, the list 
of search engines presented in the report will match the sort order of the engines in 
TopDog. It also uses the same syntax colors defined for the search engine view in 
TopDog.

· Search Engine. The name of the search engine. Click the name to go to that 
site's home page.

· Country. The country location of the search engine.
· Rank. You rank on this site. One (1) means you were TopDog. Color highlighting 

is used on this report to indicate movement of your web site on the search 
engines. For more information on what colors mean, see the Search Engine List 
topic.

· Page. This is the first page that your site was found on.
· Position. This is the position on the page that your site was first found on.
· Status. This lists the number of pages and results that were received from the 

search engine. If your site was listed on a search engine, the URL's that matched 
are listed here. They are presented as hyperlinks for easy navigation.

Keyword Summary
The Keyword Summary report is very similar in contents to the Summary report. The 
difference is that this report groups by search engine, listing all of the keyword sets below 
the search engine. Then Keyword summary report contains the following information:

· Project Name. This is the name of the project file without the path information.
· Run Date. This is the date and time that this search was started.
· Performed For. This is the information entered into the URL Addresses field on the 

Search Form.
· Hot-links. This is an index to all of the search engines listed in the report. Click on an 

engine to jump to that section of the report. The index is in alphabetical order.
· Search Engine Group. This is the Search Engine list from TopDog. If an engine has 

been disabled in TopDog, it will not show up on this report. Below the search engine 
name is the information for each of the sets of keywords. 

· Keywords. The set of keywords for which the information follows.
· Rank. You rank on this site. One (1) means you were TopDog. Color highlighting 

is used on this report to indicate movement of your web site on the search 
engines. For more information on what colors mean, see the Search Engine List 
topic.

· Page. This is the first page that your site was found on.
· Position. This is the position on the page that your site was first found on.
· Status. This lists the number of pages and results that were received from the 

search engine. If your site was listed on a search engine, the URL's that matched 
are listed here. They are presented as hyperlinks for easy navigation.



Submission Summary
The Submission Summary report contains the following information:

· Project Name. This is the name of the project file without the path information.
· Run Date. This is the date and time that this submission was started.
· Performed For. This is the information entered into the URL With Prefix field in the 

Project Properties Submit Info tab under Common.
· Statistics. 

· X eligible search engines. Where X is the number of search engines in the 
enabled search engine list that TopDog supports submission on. Note that some 
of the enabled search engines may not support submitting. (i.e., MSN does not 
support submission at this time.)

· X successful submissions. Where X is the number of search engines that were 
successfully submitted to. If you are using the auto-submit feature in TopDog, 
some engines may say 'Not yet submitted'. This merely means that your ranking 
on the search engine was good enough to not submit to at this time.

· X unsuccessful submissions. Where X is the number of submissions that 
failed. Not yet submitted does not mean a submission failed. It just means the 
search engine was not submitted to at this time. If submission fails on a search 
engine, use the right lick menu in the search engine view and select Submit 
Results to view the submission results page. This will tell you why the submission 
failed and give you a chance to correct the problem.

· X not yet submitted. Where X is the number of search engines that were not 
submitted. These are usually the search engines that you already have good 
ranking on and your are performing an auto submit.

· Score XX%. Where XX is the percent of search engines that were actually 
submitted to.

· Search Engine Summary. This is the Search Engine list from TopDog. If an engine 
has been disabled in TopDog, it will not show up on this report. Furthermore, the list 
of search engines presented in the report will match the sort order of the engines in 
TopDog.

· Search Engine. The name of the search engine. Click the name to go to that 
site's home page.

· Country. The country location of the search engine.
· Count. This is the total number of times you have submitted to this search 

engine.
· FirstSubmit. This is the first time the search engine was successfully submitted 

to.
· LastSubmit. This is the last time the search engine was successfully submitted 

to.
· LastAttempt. This is the last time TopDog tried to submit to this search engine. 

It is updated for both success and failure.
· Status. If a search engine is submitted to, this is either Success or Failed.

Email Report
Use the Email report option to email summary reports from within TopDog. This feature is 
useful if you are tracking web sites for customers and are sending them regular updates as 
to how their web site is doing in the search engines. This menu option is missing if a Simple 
MAPI client is not enabled on your computer. See Enabling Simple MAPI Client in the 
Troubleshooting section for help on enabling Simple MAPI. Or, visit our web site's support 
FAQ for the latest information.



Tools

The Tools menu is depicted below:

The Tools menu is where you go to open either the home or add URL page for the selected 
search engine, customize the Tools menu, and set the program options for TopDog. In the 
menu above, FrontPage 2000 is listed as an example.

Open Home Page for <Search Engine>
Select this option to launch your web browser and load the selected search engine's home 
page. You may also access this function from the right-click menu in the Search Engine view 
by selecting the search engine name in the menu.

Open Add URL Page for <Search Engine>
Select this option to launch your web browser and load the selected search engine's add 
URL page. If and add URL page does not exist for the selected search engine, this option 
takes you to their home page. This option is also available from the right-click menu in the 
Search Engine view.

Customize
Select this option to add your own programs to the Tools menu. Examples would be to add 
programs like Windows Explorer, Web Browser, FTP Client, HTML Editors, etc.... See 
Customize in the dialog box reference for more information.

Options
Options is where you go to select search engines to include, optimize TopDog, and set your 
color preferences. Select this menu item to bring up the Search Options dialog box. From 
there you can select any one of the tabs to make your changes to. The Search Options 
dialog remembers the last tab you were on and always shows that one first when reopening 
it. This option is also available from the right-click menu in the Search Engine view.

· Search Engines. Selects the search engines to include/exclude.
· Searching. Adjusts how TopDog handles results from the search engines.
· Performance. Optimizes TopDog for a particular computer and internet connection.
· Output. Sets the reports output directory.
· HTTP Proxy. Selects the use of a proxy, if needed.
· Colors. Adjusts the screen colors to your liking.
· Reports. Customize the headers and footers on the reports.
· Language. Change the language resources for the program.



Help

The Help menu is depicted below:

The Help menu is where you go to get help on TopDog. From here you can bring up this 
Help file, jump to the TopDog web site, check for program updates, purchase TopDog (if you 
already haven't done so), and see what TopDog is about.

Help Topics
This brings up the Help Topics dialog with the Content tab showing. From here you can 
browse the online help, search the index, or find help on specific topics.

Tip of the Day
This brings up the Tip of the Day dialog. Use this option if you want to read more tips.

Tip of the Day dialog

· Show Tips at Startup. Uncheck this option if you no longer want the Tip of the Day 
dialog to show when TopDog starts.

TopDog on the Web
The TopDog on the Web submenu is depicted below. This menu provides convenient links to 
common places on our web site.



· The Dog House. Click this link to jump to the TopDog Home page. This is where you 
will find links to all of our other stuff, including other web positioning resources.

· What's New. Click this link to jump to the TopDog What's New page. Here is where 
you will find out about any new features or updates to TopDog.

· Online Support. Click this link to jump to the TopDog Support page. Here you can 
submit a report request.

· Submit Feedback. Click this link to jump to the TopDog Feedback page. Here you 
can submit some feedback on TopDog -- usually feature request.

· Tell a Friend. Click this link to jump to the TopDog Tell a Friend page. If you really 
like TopDog and would like to tell a friend, come here. We have made it really easy for 
you to send an informative piece of email to your friend about TopDog.

Check for TopDog Update...
TopDog automatically checks for updates once a day, but you can override this and force 
TopDog to check for an update whenever you need to. TopDog does not check for updates 
behind the scenes. It only checks when the program is run for the first time during the day. 
Multiple runs during the same day do not check for updates.

Purchase TopDog...
If you have not already purchased TopDog, come here to do so. Purchasing TopDog is quick 
and easy, and should only take a couple of minutes. By purchasing TopDog, you will unleash 
the full power giving you access to all of the supported search engines and Instant Updates 
for one year.

Renew Instant Update Subscription...
When your Instant Update subscription runs out, come here to renew it. Renewing your 
Instant Update subscription ensures that you always have the latest version TopDog. This 
includes any new search engines added, any changes to existing search engines, and 
complete software updates for one year.

About TopDog...
Displays copyright and license information. You can also check the version numbers of all 
TopDog software modules here, as well as view the Credits dialog. If you have download 
TopDog from one of our resellers/partners, information about them will also be listed here.



Right-click Menu

The popup menu in the search engine view is your way to quickly access frequently used 
functions. There are also a few items on this menu that are not available from the main 
menu. Usually these items are specific to the selected search engine.

Search Engine View Popup Menu

Popup Menu
· Details Report. See Details under the Reports menu.
· Summary Report. See Summary under the Reports menu.
· Keyword Summary Report. See Keyword Summary under the Reports menu.
· Submission Summary Report. See Submission Summary under the Reports menu.

· Engine Name. This menu item indicates the currently selected search engine. Click this 
menu item to launch that search engine's home page.

· Search. See Search Selected under the Search menu.
· Auto Submit. Submits your web site to the selected search engine based on your 

Submission Rules. Be sure a fill out the Submit Info tab on the Properties dialog before 
submitting.

· Open Add URL Page. This option launches your web browser and opens the selected 
search engine's add URL page (if one exists).

· Show Last Submission Results. After submitting to a search engine, this opens your 
web browser and displays the results page of your last submittal. If you get a Submission 
failed returned from a search engine, use this option to determine the reason.

· Mark As Submitted. If you have already submitted to a search engine, use this option to 
let TopDog know that you already submitted. This option is mainly for search engines that 
TopDog does not support submission on - yet.

· Options. See Search Options under the Tools menu.



Search Form

The Search Form is depicted below:

The Search Form is where you enter information about your web site and the keywords you 
think customers will use to find your web site. This information is saved with the project 
files so you can run comparison searches again later.

URL Addresses
Enter your web site URL here. TopDog will use this information when scanning the results 
returned by the search engines to determine if a result matches. When entering multiple 
domains, use the ellipsis button to the right (...). This provides you a convenient interface 
for entering multiple URLs.

Also, when entering multiple URLs, TopDog performs a logical OR operation on the results. 
So only one search term has to match for the result to be counted as a match. For example, 
if you entered the URL Addresses as "dcmicro.com crusher", any results returned from the 
search engines that contained either "dcmicro.com" or "crusher" would count as a match.

Furthermore, you do not have to enter just URLs. You could also enter product or service 
names, like in the example above. Basically, anything that you think the search engines 
might return that could match your web site is acceptable.

 

NOTE:    The URL addresses entered here are NOT the ones used when submitting your web 
site. Those are entered in the Submit Info tab of the Properties dialog box.

 

Search Terms
Enter any search terms or phrases that you think your customers might type in when 
looking for your web site, product, or service. Keep your search terms and phrases short. 
Most people will enter vague terms in hopes of narrowing a search down. So if you sell 
Diamond Back mountain bikes, don't enter "Diamond Back". Try using a more general 
phrase like "Mountain Bike" first. Do not enter all of your keywords from your meta tags 
here! TopDog will pass down the entered search terms to the search engines when 
performing a search. And, of course, you wont be listed on any search engines for such a 
larger set of keywords.

When entering multiple sets of search terms, use the ellipsis button to the right (...). This 
provides a convenient interface for entering multiple sets of search terms. If a project is 
created with multiple search term sets, TopDog will search each set in turn on a Search All. 
Search Selected will only search the selected search engine for the current set of search 
terms (the ones displayed in the form view). If your project contains multiple sets of search 
terms, your summary reports will include information for each set of search terms.

 

NOTE:    The search terms entered here are NOT the ones used when submitting your web 



site. Those are entered in the Submit Info tab of the Properties dialog box.

 

Enter Search Term Sets dialog

· New Search Term Set. Enter a set of search terms here, then click the Add button 
to add them to the list of search term sets. If you would like to add more than one set 
at a time. Enter each search term on a separate line, then click the Add button.

· Add. Adds the set of search terms entered in the edit field above to the list of search 
term sets.

· Search Term Sets:
· Current Set. Displayed above the list of search term sets is the current set of 

search terms. These are the search terms that are current in the search form 
display -- the ones you see from the main window. You can change the current set 
using the Set Current button (<Ctrl+T> from the main window).

· Search Term List. This is a list of your search term sets for the active project. By 
default all search term sets are enabled. 

· Enable/Disable. To disable a search term set, remove it from the search process 
during a Search All, click the box to the left of the set of search terms. This will 
toggle the checkmark that indicates if this set is included or excluded from a 
Search All. 

· Edit Search Terms. Optionally, you can edit an existing set of search terms. 
Select the set of search terms with your mouse, then select them again. The set of 
seach terms should now have an edit box around it and you should be able to edit 
them with the keyboard.

· Remove. Click Remove to delete the highlighted set of search terms from the keyword 
list.

· Set Current. Click this button to set the highlighted set of search terms current. This 
is how you change from one set of search terms to the next in the search engine view. 
You can also double-click a set of search terms in the list to make them current. 
Alternately, from the search engine view, you can use the hot key <Ctrl+T> to toggle 



(cycle) through all of the available sets of search terms. This is useful when you want 
to look at the results from a search quickly, without going to the Enter Search Term 
Sets dialog.

Examples Search Term Usage:

Search Terms What I'm Looking For...
childcare software Software to run my daycare with.
y2k food bulk A dealer that deals in bulk foods specialized for y2k.
toolkit compression c++ A data compression toolkit written in C++ programming 
language.
mountain bike accessories A company that sells accessories for my mountain bike.

For more information on entering search terms, see the Search Engine Tips chapter.



Search Engine List

The Search Engine List is depicted below:

The Search Engine List is where it all happens. Here you can view results as they happen. 
No waiting for the searches to finish before you see the results. You can even run the 
reports and jump to the web sites while TopDog is searching. Use the right mouse button to 
access the popup menu.

Below is a list of the columns with the information that is presented in each. The column 
headers can be clicked to sort the search engine list by any column. The default sort 
is on the Search Engine column in ascending order. Click the column header a second time 
to sort in descending order.

 

NOTE: When generating a Summary or Submission Summary report, the Search Engine list 
in the report will be in the same sort order as the Search Engine List view. Furthermore, any 
disabled search engines will be excluded from these reports.

 

Color Highlighting
When running a search for a second time, color highlighting is used to show any movement 
in position on the search engines. This is helpful when tracking ranking on the search 
engines after changing your web site and resubmitting. It is also useful for determining 
where you rank among your competitors. Listed below are the default colors used to 
indicate movement in the search engines. These colors can be changed through the Search 
Options Color tab.

· Green. This color is used to indicate that your web site has moved up in ranking on 
this search engine. Or, if comparing against a competitors web site, to indicate that 



your web site ranks higher. The number in parenthesis to the right of the ranking 
indicates by how many positions your web site ranks higher.

· Red. This color is used to indicate that your web site has moved down in ranking on 
this search engine. Or, if comparing against a competitors web site, to indicate that 
your web site ranks lower. The number in parenthesis to the right of the ranking 
indicates by how many positions your web site ranks lower.

Search Engine
This is the name of the search engine.

Ranking
This is your current ranking on the search engine for the keywords you have chosen. 
Different keywords could produce different rankings. The ranking is based on the number of 
total results received from the search engine. A ranking of one (1) indicates that you were 
the first result returned by the search engine -- you were TopDog!

Page
This is the first page your web site was found on. Most search engines break up the search 
results into pages for easier browsing. You goal is to always be listed on page one (1).

Position
This is the ordinal position within the first page that matched your URL Addresses 
information from the Search Form. This is not the same as rank. Your goal is to always be 
position one (1) on page one.

Status
This is the current status of the search engine. While a search is in progress, extra 
information is given here to help determine where the search is at. When a search is 
finished, the status text changes to one of five options. The last two options will only show 
when TopDog is submitting your web site.

· TopDog! You were TopDog on this search engine. This means you ranked number 
one and were on page one position one of the search results.

· Listed (X pages, Y results received). You were listed on this search engine, but 
not TopDog. X is the total number of pages returned by the search engine, and Y is 
the total number of results returned within those pages.

· Not Listed (X pages, Y results received). You weren't listed on this search engine 
at all within the results received. X is the total number of pages returned by the 
search engine, and Y is the total number of results returned within those pages.

· Submission Succeeded. Your web site has been submitted to this search engine.
· Submission Failed. Submission to this search engine has failed. Right click the 

search engine in the list and select Submit It Results from the popup menu to find out 
why submission has failed. It is usually due to a lack of information in the Submit Info 
tab or the Properties dialog.

Other Statuses
Below is a list of other statuses that can display while TopDog is working. Depending on 
the speed of your computer and internet connection, you may not see some of these 
(they can go by quickly) statuses. But, here is a list of them if you are interested.

· Page #1 requested. Issued when a results page is being requested from the 
search engine.

· Contacting Host. Issued when a search engine is first contacted for a search and 



each page after.
· Connected. Issued when a successful connection is established with the search 

engine.
· Unable to connect to server. Issued when TopDog cannot connect to the search 

engine.
· User canceled. Issued when the user clicks the Stop button or attempts to close 

TopDog.
· Connection lost. Issued when the connection with the search engine is lost. 

Reduce the number of threads when this happens a lot.
· Timed out (1 page, 1 result). Issued when a connection times out and some 

information has been received. Reduce the number of threads when this happens a 
lot.

· Timed out (no info received). Issued when a connection times out and no 
information has been received.

· Timed out (no pages received). Same as above.
· Waiting for response. Issued when TopDog is waiting for a search engine to 

respond to a search request.
· Receiving page #1 . . . (45%) or (15 KB). Issued when TopDog is receiving 

search information from a search engine. Where you get percents or kilobytes 
depends on the search engine.

· Page #1 received. Issued when the page download is complete.
· Analyzing results. Issued when TopDog is scanning the returned page for 

matching results.
· Please Submit Manually. Issued for search engines that either don't support 

submission or TopDog does not support it yet.
· Submitting Site. Issued when TopDog has begun to submit your web site to the 

search engine.



Status Bar

The Status bar is depicted below:

When you hold your mouse cursor over a pane in the status bar, a tip shows with relevant 
information on that pane. Also, if you double-click any numbered pane, an information 
dialog box shows with more ranking information. 

The Status bar consists of seven status panes. Their function is listed below.

1. This is the tip area. When you browse the main menu, the text here is updated with a tip 
for that menu item. Also, while searching, it acts as an info pane, displaying the current 
set of keywords.

2. This is the number of search engines you are not listed on. In a new project, this 
number equals the total number of selected search engines until a search is performed. 
When a search is in progress, this number will update automatically.

3. This is the number of search engines that you have moved up in ranking in. This number 
is not computed on the first search of a new project. When a search is in progress, this 
number will update automatically.

4. This is the number of search engines that you have moved down in ranking in. Again, 
this number is not computed on the first search of a new project. When a search is in 
progress, this number will update automatically.

5. This is the number of search engines you are TopDog in. When a search is in progress, 
this number will update automatically.

6. This pane has two functions. One, it shows a count of engines that are selected verses 
the total number of search engines that are available. And, second, it acts as a progress 
meter when any functions in TopDog are performed that take a little time (i.e., 
performing a search or submission).

7. Double-click this icon to find out when the last search on this project was performed. 
You can also hold your mouse cursor over the icon to get a tip with the same 
information.



Export to CSV

Use this option to export your active project file to a comma separated values file. This file 
is importable by most spread sheet and database programs.

Export to CSV dialog box

· Path. Enter the path where to save the newly created export file. The default value 
comes from Project|Properties... and the Output tab. If you enter a path that does not 
exist, TopDog will attempt to create the path for you.

· File Name. This defaults to the name of your project file with a '.csv' extension. You 
can change this to any valid file name. Microsoft Excel® and most other popular spread 
sheet and database programs can import this file directly if the extension is left as 
'.csv'.

· Include Header Row. Check this option to include a header row in the export file. 
This makes the first row a row of labels for each of the exported field values. Use this 
option when exporting data to a file for the first time.

· Append data to an existing file. Check this option to have TopDog append the 
exported data to an existing export file. The file must already exist to use this option. 
Be sure and Uncheck Include header row when using this option. This option is helpful 
when you want to track the history of position changes on a web site.

Output Header
Search Engine, Country Code, Ranking, Page, Position, First Submit, Last Submit, Submit 
Count, Date

Example Data Output
"Yahoo","US",3,1,3,02/12/1999,04/29/1999,3,04/29/1999
"Infoseek","US",22,2,12,04/29/1999,04/29/1999,1,04/29/1999



Select Search Engines

The Select Search Engines dialog box is where you go to select which search engines to 
include in a search. The selections here are not saved from session to session, but are 
saved with the project files.

Select Search Engines dialog box

· Search Engine List. Using the mouse, select the checkbox next to a search engine 
to toggle its selection state. A check means that engine is included in the search. To 
help narrow down your selections, the country, language, and category of each search 
engine are provided. Each column in the list can be sorted either ascending or 
descending by clicking on the column header.

· Engines Selected. This is the current number of search engines that are selected.
· Total. This is the total number of search engines that are available.
· Only show enabled search engines in the Search Engine view. Select this 

option if you don't want to see disabled search engines in the search engine view. If 
you have limited screen space, this option is good to check.

· Select All. Click this button to select all of the search engines in the list.
· Deselect All. Click this button to deselect all of the search engines in the list.
· Toggle Highlight. Use this button to toggle the currently highlighted search engines. 

Any search engines highlighted that were checked become unchecked and vis versa. 
Use the <Ctrl> and <Shift> key for more selection options.

· Select By. Click this button to display a dialog box that allows you to select search 
engines by matching criteria.

· Templates. Click this button to display a dialog box that allows you to save the 
current search engine selection as a template. You can also load previously saved 
template for this dialog box.



Select By

Use this dialog box to select search engines based on specific criteria. This is helpful when 
you have many search engines to select that match certain criteria.

Select By dialog box

Selection Criteria
· Category. Select a category from the list, or leave blank to include all categories. 

Currently there are four categories; Business, Family, General, and Software. Business 
are like Service911 and NationalDirectory. Family are like Disney and Searchopolis. 
General are what we think of as the traditional search engine like Yahoo, Alta Vista, 
and others. Software are shareware sites like 100hot and SoftSeek.

· Country. Select a country from the list, or leave blank to include all countries. 
Standard two letter abbreviations are used (i.e., US=United States, MX=Mexico, 
UK=England, etc...)

· Language. Select a language from the list, or leave blank to include all languages. 
Language is useful when a search engine in a particular country is presented in a 
language other than the native. For example, QuePasa.com is a US search engine that 
is in spanish.

· Submittable Search Engines Only. Select this option to exclude search engines 
which TopDog does not support submission to.

Selection Options
· Select these engines only. Select this option if you want to erase your current 

selection before applying the selection criteria.
· Select these engines plus those already selected. Select this option if you want to 

keep your current selection, plus select those engines that meet your new selection 
criteria.



Templates

Use this dialog box to save, select, and remove search engine templates. A template is a set 
of search engines that you might regularly use -- like a Top 10 or International only 
selection. You can save as many templates as you like, limited only by hard disk space.

When you first enter this dialog box, the fields are blank. This is so you can save the current 
search engine selection as a template. If you are not interested in saving a template, simply 
select the template from the template list and click Select. Or, click Remove, if you want to 
remove the template from the list.

Templates dialog box

· Template. When saving a new template, enter the name here. Otherwise, select a 
template name from the list and click Select or Remove. Use Select to select the 
current template into the search engine list on the Select Search Engine dialog box. 
Clicking Remove will delete the current template from the list and will no longer be 
available.

· Description. Enter a description for the template you are about to save. This field can 
be left blank if the template name is descriptive enough.

· Save. Click this button to save the current search engine selection as a template. You 
must give the template at least a name to save it.

· Remove. Click this button to remove the current template from the list. This template 
will not longer be available.



Submit Info

Edits the submission information needed by the search engines. Depending on the search 
engines you have selected for submitting, you may not be presented with all of the available 
information. Only the properties relevant to the current engine selection will be shown. If 
you add engines in the future, be sure to come back here and enter any new information 
that may be required.

TopDog is very intelligent when it comes to submission to search engines. TopDog will even 
email search engines that only support submission by email! TopDog also maintains an 
extensive list of categories used by all of the search engines. You no longer have to 
manually submit to search engines that are category based, TopDog does it for you. For 
directory based search engines like Yahoo, TopDog provides a convenient interface to gather 
the latest categories straight from the search engine's web site. Now submission to Yahoo is 
a breeze!

Please note that the information gathered here is an aggregation of data requested by all of 
the supported search engines. Data that is not requested by a search engine's submission 
interface is not given to that engine. No back doors are being used when submitting to the 
search engines for you.

Properties - Submit Info Tab

Submit Info Tab
· Property Tree. Expand a branch of the tree to expose a property you can edit. When 

a property value has been entered, a green check appears inside the box to the left. 
This is an indicator that a value has been entered for this property. If a value has been 
entered, a tooltip window will appear over the property with the value entered when 
the mouse is paused over the property. The screen shot above shows Document 
URL(s) with two domains entered.

· Modify Button. Click the <Modify> button to edit the value of the selected property 
in the tree. Or, double-click your mouse on a property to edit the value.

· Import Button. Click the <Import...> button to import properties from a web page. 
See below for more detailed information.

Some Properties Explained
· Document URL(s). Enter the URL's that you wish TopDog to submit for this project. 

Most projects only consist of one URL, but some many contain multiple -- especially 
when submitting doorway and hallway pages for a web site.

· Email Address. This is usually the email address for the webmaster of the domain 
being submitted. Any submission confirmations sent by the search engines are usually 
sent to this email address.

· Primary Language. Usually just the name of your country.
· Keywords with spaces. This is usually from your meta tags keywords section from 

the default page of the domain you are submitting (e.g., default.html or index.html). 
The keywords need to be separated by spaces. For example, "child care software 
childcare accounting management", without the quotes.



· Keywords with commas. This is usually from your meta tags keywords section from 
the default page of the domain you are submitting. The keywords need to be 
separated by commas. For example, 
"child,care,software,childcare,accounting,management", without the quotes.

· Title of Site. This is usually from your meta tags Title section from the default page of 
the domain you are submitting.

· SMTP Server. This is the name of your outbound email server. TopDog uses this 
server to send email to search engines that require submission by email. If you are 
unsure of this value, check your account options in the email program you are using. 
Look for a setting that asks for either the SMTP server or the outbound mail server 
name and use it here. If that doesn't work, ask the person who set up your email 
program for the correct name.

Modify Value Dialog

Modify Value
When modifying a property value, the Modify Value dialog box is displayed. This dialog 
box allows you to edit the properties of the items in the list. The edit field changes to 
allow editing of different types of data. When more than one line of text is required, the 
edit field expands and becomes a multiline edit control. If you are choosing a category 
for a search engine, the edit field changes to a drop down list to display a list of category 
choices. If the category is for a directory based search engine, like Yahoo, then a tree 
control is displayed to allow you to drill-down to the specific category. The tree is loaded 
dynamically from the web when a choice is made, so some categories may take longer 
to load then others.

· Description. A brief description of the value needed for this property is displayed 
here.

· Translate. This button only shows up when a translation is needed and it is possible 
for TopDog to attempt the translation for you. If this button is present, TopDog will 
attempt to translate the text from the current language to the language needed. 
Currently, TopDog uses the internet to retrieve the translation. Therefore, an 
established internet connection is needed when using this option. TopDog will attempt 
to establish the connection if one is not present.



Import Properties Dialog

Import Properties
Use the Import Properties dialog to retrieve property information from a web page. 
When you click <Import...> from the Properties dialog, Import Properties will extract 
the first URL in the Document URLs field and enter it for you automatically. If you are 
importing from a different URL, select the URL text and enter the new URL. Click 
<Import> to import the properties from the web page entered. Please note, no attempt 
is made to import text from improperly formatted html code. If Import fails to import 
any text, this is a good signal that the search engines probably won't be able to read 
your page either.

Properties Imported
· Keywords with spaces. Any keywords in the META tag KEYWORDS section of the 

web page. If any commas are present, they are stripped from the text.
· Keywords with commas.    Any keywords in the META tag KEYWORDS section of the 

web page. If no commas are present, they are NOT added.
· Title of Site. The <Title> section text of the web page.
· One-line Description. Any description in the META tag DESCRIPTION section of the 

web page. This description is also inserted into the language variations of this field.
· Short Description. Same as One-line Description.
· Long Description. Same as One-line Description.



Submit Rules

Sets up the rules TopDog will follow when submitting your web site to the search engines. 
Use this option wisely. Re-submitting your web site too often can cause you to loose ranking 
on some search engines! Furthermore, if you don't change the content of your main page, 
re-submitting will not help. If you are not listed on a search engine after submitting (Give it 
time! Some engines can take up to three months before listing your site.), change the 
content of your home page. See the Tips section of this help file or the TopDog Tips section 
on the web site for more current information about changing your home page for submitting 
to the search engines.

By default, automatic submission is turned off for existing and newly created project files. 
And again, any settings entered into the properties dialog box are saved with the active 
project file. Furthermore, if a submission fails on a particular search engine, right click that 
engine and click Show Last Submission Results. This will show the actual page returned 
from the search engine. Use this information to correct the problem and re-submit. If you 
do a second search on the project after correcting any submission problems, TopDog will 
attempt to submit to the failed search engines again. If only a few failed, right-click the 
failed search engines one at a time and click Auto Submit.

Properties - Submit Rules Tab

Submit Info Tab
· Automatically submit to a search engine when finished searching and it meets 

the submittal rules below. This one is pretty self explanatory. When unchecked, the 
options below are grayed out. Checking this option will increase the size of your project 
file on disk.

· Never submit to TopDog sites. Check this options to keep TopDog from submitting to 
sites that you are already TopDog on. Re-submitting to search engines that you are 
TopDog on is not a good idea. Re-submitting could actually make you loose your position 
on that search engine.

· Only submit to search engines that I'm not listed on. Check this option if you are 
only concerned about being listed on search engines. When this option is checked, the two 
options below are grayed out and unavailable.

· Ranking is below. Check this radio button and enter the ranking value that will trigger a 
submittal. If you enter the number 10, TopDog will not submit your web site to an engine 
if you rank between 1 and 10 on that search engine. If your ranking is either 0 or 11 and 
greater, TopDog will submit your web site.

· Page Number is below. Same as Ranking is below, but uses page number instead.
· Limit Submittal to. Select either Daily, Weekly, or Monthly for this option. This tells 

TopDog the frequency of which to submit your web site. It is probably wise to keep this 
setting at Monthly. Submitting to the search engines repeatedly in a short amount of time 
can be considered spamming, and you could be black listed from that search engine for 
good! Not a good thing.

Developer Notes
You can change or add new default values for all of the options on this dialog using the 



system registry. Open the system registry editor and add one or more of the following 
DWORD values to the HKEY_CURRENT_USER\Software\The Dog House\TopDog\Defaults 
section.

Key Value Description
SubmitAuto [0|1] 0=false, 1=true
SubmitLimit [0|1|2] 0=daily, 1=weekly, 2=monthly
SubmitWhen [0|1] 0=Ranking is below, 1=Page Number is below
SubmitRanking X Where X is a number that is greater than zero
SubmitPageNo X Where X is a number that is greater than zero
SubmitTopDog [0|1] 0=Submit to TopDog sites, 1=Never submit to TopDog 
sites
SubmitNotListed [0|1] 0=Use Submit When settings, 1=Only submit to not 
listed search engines.

If you are unsure of how to use the system registry, start the registry editor by selecting 
Start|Run... from the task bar and entering REGEDIT and tapping the <Enter> key. This will 
start the registry editor. From there, select Help|Help Topics from the main menu. That will 
get you into the help on using the registry editor.



Email

Sets up the default email to account for emailed reports. If this information is left blank, you 
will be prompted for it when you first email a report. This information is specific to a project.

Properties - Email Tab

Email Tab
· To. Enter the email address for the person receiving emailed reports for this project file.
· Cc. Enter the email address of anyone you wish to CC the Summary report to.
· From. Enter your email address here. This address is used as the reply to address for the 

email. It defaults to the email address you entered when purchasing or registering 
TopDog.

· Subject. Enter any text that you wish to appear in the subject line of the emailed report.
· Body. Enter a body for the email message. If the body is left blank, the Summary report 

will show in the body of the email. Otherwise, the Summary report will show as an 
attachment. 

Developer Notes
You can change or add new default values for Cc, From, Subject, and Body using the system 
registry. Open the system registry editor and add one or more of the following string values 
to the HKEY_CURRENT_USER\Software\The Dog House\TopDog\Defaults section.

Key Value
EmailCc anotheremail@domain.com



EmailFrom youremail@mydomain.com
EmailSubject your subject text.
EmailBody your email body text.

If you are unsure of how to use the system registry, start the registry editor by selecting 
Start|Run... from the task bar and entering REGEDIT and tapping the <Enter> key. This will 
start the registry editor. From there, select Help|Help Topics from the main menu. That will 
get you into the help on using the registry editor.



Output

See Output under the Search Options section of the help. This option is provided as an 
override to the default settings.

Properties - Output tab

Note: If a project file is emailed to you, it is possible that the output directory stored in the 
project file will not exist on your computer. If this happens, TopDog will use the default 
directory setting under Search|Options... and Output tab from the main menu. If for any 
reason this directory does not exist, TopDog will use your root directory on drive C for 
reports (highly unlikely).



Customize

Use this dialog box to set up your Tools menu. This allows you to add new programs to the 
Tools menu, so they can be launched from within TopDog. A good choice of software to add 
to the Tools menu would be any HTML editor that you use, possibly an FTP program, and 
may be others.

When new add-ons come out for TopDog, they will install to your Tools menu. Any tools that 
you have added will be left intact when TopDog installers any new add-ons.

Customize dialog box

· Menu Contents. This list displays the content of your Tools menu. That is, the 
program that you have added or that have been installed by TopDog.

· Menu Text. Enter the text you wish to show on the Tools menu here. Use an 
ampersand (&) in front of a character to give it a menu shortcut key. (e.g., Adobe 
&PageMill 3.0 would become Adobe PageMill 3.0)

· Command. Enter to the full path to the executable program here. Use the ellipse (...) 
button to browse for a program on your hard disk.

· Arguments. Enter any arguments to pass down to the program.
· Initial Directory. Enter the folder you whish to have the program start in. Use the 

ellipse (...) button to browse for a folder.
· Add. Click Add to create a new entry in the Tools menu.
· Remove. Click Remove to delete the currently selected menu item in the Menu 

Contents list.
· Move Up. Click this button to move the currently selected menu item up one position.
· Move Down. Click this button to move the currently selected menu item down one 

position.



Searching

The Searching tab is where you go to modify how TopDog retrieves results from the search 
engines. Several options are available here. To adjust the number of results to retrieve, 
when to stop if a matching URL is found, the use of keyword alerts, how new search engines 
are added to existing projects, and how to find matches for entered URL Addresses.

Search Options - Searching Tab

Searching Tab
· Enter the maximum number of results you would like TopDog to scan from a 

search engine before stopping. Each search engine on the web will return a varying 
number of results depending on the key words used to search by. This field allows you to 
adjust the number of results to receive from a search engine before giving up. At 50 
results, the search engines will usually return up to five or six pages. Some search 
engines list categories before the actual search results are returned, these count as 
results to TopDog.

· Shallow search. Checking this option tells TopDog to stop the search on a particular 
search engine when a match for the URL(s) you have entered has been found. This speeds 
up the searching time, but limits TopDog from telling you if your URL(s) are found more 
than once for a particular set of key words.

· Use Keyword Alerts. Check this option to have TopDog remind you when you have 
entered to many keywords or have improperly formatted the keywords. As an example, 
"childcare,software,accounting" is an invalid set of keywords. All search engines will treat 



this as one big word. Therefore, you wont be listed on any search engines. The proper 
formatting would be, "childcare software accounting".

· Ignore these characters. This tells TopDog to ignore any of the characters in this field 
when entering keywords. They will not be entered into the keywords field.

· Include new search engines when opening saved projects. Check this option if you 
want TopDog to add new search engines that weren't available when a project was 
originally saved.

· Restrict URL matches to hyperlinks. Check this option if you want TopDog to only 
check the hyperlink of a search engine result when comparing for a URL match. This 
effectively tells TopDog to NOT search the description text of the search engine result 
when determining if a result matches your URL address. WARNING: THIS OPTION WILL 
CAUSE PROJECT FILES TO LOAD MUCH SLOWER!



Performance

The Performance tab is where you go to modify options that affect the speed and reliability 
of the searches performed. These options are defaulted to adequate values for most dialup 
connections. If you have a dedicated connection, you may want to adjust these settings. 
These options only affect the how TopDog uses your internet connection. As far as computer 
CPU usage, TopDog is very efficient and uses a minimum amount of CPU time (usually less 
than 20%).

Search Options - Performance Tab

Performance Tab
· Limit Bandwidth. Check this option if you want to limit the amout of bandwidth 

(connection speed) TopDog uses when searching and submitting. When this box is 
checked, enter the maximum amount of bandwidth in the field below.

· TopDog should use a maximum bandwidth of. Adjust this number to the maximum 
amount of bandwidth TopDog should use. A typical modem connection has a maximum 
bandwidth of 2 to 4 KBps. An ISDN connection usually has around 12KBps.

· Optimize threads. Check this option if you want TopDog to optimize the number of 
threads based on the available bandwidth. When a search or submit is started, TopDog 
will start out with 3 threads and evaluate the bandwidth every 10 seconds increasing the 
number of threads while the bandwidth can handle it. At two minutes TopDog will stop 
evaluating and use the number threads that are now currently running. On a typical dial-
up connection, TopDog will adjust to about 4 threads. For an ISDN connection, the 



number of threads can increase to as much as 10.
· Maximum number of searches to perform at one time. This number can be increased 

to the number of search engines available for the current version of TopDog. This is how 
many searches TopDog will attempt at one time. The default is eight, but with a fast 
computer and a dedicated connection, you can increase this number as high as you would 
like. For performance and Windows limitations, this number should really be less than 20.

· Search engine no response time-out. This is the amount of time that TopDog will wait 
for data coming back from a search engine before timing out. If you are seeing a lot of 
time-outs, increase this number by 15 seconds at a time.

· Enable banners. Uncheck this option if you don't want to look at banner ads while a 
search is in progress (this feature is disabled in demo mode).



Output

The Output tab is where you modify the directory TopDog uses to store temporary files for 
reporting purposes. The default is the Reports directory under the TopDog program 
directory. Any files generated here are overwritten the next time a report is generated.

If you are an ISP that hosts business pages, you could use this option to provide ranking 
reports to your customers. After running a search on a customer's page, you could point the 
reports directory to a directory in their account, run any reports available in TopDog, then 
those reports would be available to them immediately.

Alternatively, you could use the email feature in your web browser to email your customers 
their reports.

Search Options - Output Tab

Output Tab
· Reports Directory. Enter the directory where you would like TopDog to store any 

temporary files used in generating reports. If the directory you enter does not exist, then 
TopDog will ask you if you want to create it. you can override this setting for individual 
project files by using the Project|Properties... and selecting the Output tab.

· Append date to file names. Use this option when you are saving printed reports for 
customers. Be sure to override the output directory using the Properties|Output tab. 
This option allows you to keep an archive of printed reports for your client or your own 



records.



HTTP Proxy

The HTTP Proxy tab is where you enable the use of a proxy server. If your internet 
connection is behind a proxy, you will need to enable this option and enter the address of 
the HTTP Proxy and the port number. If you are unsure of these settings, consult with your 
network administrator. If you are having difficultly using TopDog through your proxy, try 
entering the IP address for the proxy instead of the host name.

Note: If your network requires SOCKS compatibility, you will need to "sockify" both the 
TDUPDATE.EXE and TOPDOG.EXE applications using tools provided by your network 
administrator. This typically involves running TopDog within another "launcher" application.

Search Options - HTTP Proxy Tab

HTTP Proxy Tab
· Auto detect proxy setting. Check this option to have TopDog discover the proxy 

settings in your computer. This option generally only works when you have Microsoft 
product installed that use proxy too. (i.e., IE4 )

· Use the proxy server. Check this option to enable the use of the proxy server.
· Server. Enter the URL or the IP address of the proxy server. If you are having trouble 

connecting, be sure and try using the IP address for your proxy server (i.e., 10.0.0.4).
· Port. Enter the port number of your proxy server. This value is usually 80 or 8080.
· User. If your proxy requires you to log on, enter your user name here.
· Password. Enter your password for your user name.



Colors

The Colors tab is where you adjust the color settings of TopDog to your liking. TopDog 
defaults to standard colors for 16 and 256 color displays. If you have trouble seeing some of 
the colors on your display, you may use this dialog to change their appearance. 

The color button to the left is for text colors, and the color button to the right is for 
background colors. Click the <Apply> button if you would like to see your color changes in 
TopDog immediately.

Search Options - Colors Tab

Colors Tab
Search Form
· Normal. Choose the colors used in the Search Form.

Search Engine List
· Normal. These are the default colors used to display search engines.
· Disabled. If a search engine has been disabled, these are the colors it is displayed in.
· Highlight. The currently selected search engine is displayed in these colors.
· TopDog. If this search engine is ranked number one for the current search, these are the 

colors it will be displayed in.
· Moved Up. When running a search on a previously saved project file and you have moved 

up in ranking, these are the colors the search engine is displayed in.



· Moved Down. When running a search on a previously saved project file and you have 
moved down in ranking, these are the colors the search engine is displayed in.



Reports

The Reports tab is where you go to customize the headers and footers on the reports that 
TopDog generates. This tab is disabled in the demo and LE versions of TopDog.

Search Options - Reports Tab

Reports Tab
· Use Custom Header. Choosing this options enables the edit field below. If you enable 

this option and leave the field blank, no header is printed on the report.
· Header Text. Enter the custom text for the header. You may also enter HTML code to 

customize the look of the header.
· Use Custom Footer. Choosing this options enables the edit field below. If you enable this 

option and leave the field blank, no footer is printed on the report.
· Footer Text. Enter the custom text for the footer. You may also enter HTML code to 

customize the look of the footer.

How To...

Display a graphic
To display a graphic you must use HTML code in the header or footer. Furthermore, you 
will need to have a web site available to store the graphic. First make sure the graphic is 
in a public directory on your web site, then insert the following HTML code in the header 



or footer. Be sure and replace 'yourdomain' and 'Your Logo' with the appropriate values.

<IMG SRC="http://www.yourdomain.com/images/reportlogo.gif" ALT="Your 
Logo"></IMG>

Create a top margin for letter head
Simply insert HTML breaks, <BR>, into the header. One HTML break equals one line in 
the default font size for the browser. At 12pts, you would need six breaks to equal one 
inch. There are 72pts per inch. The example below will create a one inch margin in a 
browser that is displaying 12pt Arial.

<BR><BR><BR><BR><BR><BR>

Center text
To center text in the header or footer, surround the text with the following HTML tag.

<CENTER>Center this text</CENTER>

Change the font
To change the font in the header or footer, surround the text with the following HTML 
tag. You will need to change the font name(s) and size to what you want.

<FONT FACE="Arial, Helvetica" SIZE="-1">This is in a different font.</FONT>



Language

The Language tab is where you go to change the language TopDog is using for its resources. 
Any languages that TopDog currently support will be displayed in the language list.

When TopDog is started and a language has not been selected, TopDog will attempt to 
select the correct language based on the users Windows installation settings. If TopDog 
cannot determine the correct language, it will default to English (USA) for its resources. You 
can always come here and force TopDog to use a particular language.

When installing TopDog, only the resources of the selected installation language are 
installed. If you want to add a language after installation, you must reinstall TopDog and 
select that language during installation. By reinstalling, TopDog will add the appropriate 
language resource files. Every new language installed adds to the resources that Instant 
Update must keep up-to-date.

Search Options - Language Tab

Language Tab
· Current Language. Select the language you would like TopDog to run in. After your 

selection is made, you must restart TopDog for the changes to take affect.



/auto Command-line Option

TopDog provides a "/auto" or "-auto" command-line option that will automatically load a 
project, execute it (search & submit), save the results, then close the application, all 
without human intervention. This feature is compatible with commonly-available scheduling 
programs, including:

· the Schedule Tasks program in Windows 98 and Windows 2000
· the Plus Pak in Windows 95 (and MS System Agent)
· the "at" command-line program in Windows NT

We will cover how to use the Schedule Tasks program here, since most of you will have this 
program installed.

Using Schedule Tasks
The Schedule Tasks program can be found in the Start | Programs | Accessories | 
System Tools program group under Windows 98 and Windows 2000. Select the 
Schedule Tasks items to start the scheduler. The screen shots below are from a Windows 
2000 system.

From the main menu select File|New|Schedule Task, or double-click the Add 
Schedule Task icon. The Schedule Task Wizard displays its main screen. Click <Next> to 
continue. (This may take a while since the program builds a list of installed applications 
that are available for scheduling.)

Select the TopDog application from the list and click the <Next> button.



Enter a name for your scheduled project (e.g., "TopDog Web Site"), select when you 
want the scheduler to run it (monthly is a good choice), then click the <Next> button.

Enter the details of when you want the project to start, then click the <Next> button. 
Note that this dialog will offer different options depending on whether you chose daily, 
weekly, monthly, etc. in the previous dialog.



If Windows requires you to log onto your computer using a name and password, the 
Schedule Wizard will prompt you for that information. Enter the information and click the 
<Next> button to continue.

Place a check mark beside "Open Advanced Properties" then click the <Finish> button. 
This will allow us to enter the necessary command-line options.



In the Run field, insert the command-line option "/auto" (without the quotes) and the 
filename of the TopDog project file you wish to run. Be sure to leave a space between 
the application name and the "/auto" option and between the "/auto" option and the 
filename. If you are running TopDog over a network or running Windows 95, you may 
need to use the "-auto" option instead. Sometimes the backslash ("/") can be mistaken 
for a path separator.

Next, enter the name of the folder containing your project file in the Start in field. Be 
sure to include the quotes as we have done in the example above. When you are 
finished, click OK. As long as your computer is turned on when the time arrives, the 
Schedule Tasks program will automatically execute your TopDog project.

Tips...

Scheduling More than One Project
When scheduling more than one project, be sure to leave ample time between them so 
that they do not overlap. Estimate the amount of time required to complete a project 
and schedule the next one accordingly.

Popup Dialog Boxes
When TopDog is run in the "/auto" mode, any dialog boxes that can interrupt the 
running project are disabled. This helps provide the "hands-free" operation. Due to that, 
TopDog will NOT check for an update in "/auto" mode. It is advised that you manually 
check for an update every couple weeks when using TopDog in the "/auto" mode. See 



Help for more information on checking for an update.



Comparing Previous Results

Some of the power of TopDog comes to play when comparing search results. This allows you 
to see if your web site has moved up or down in the rankings. To do this follow the steps 
outlined below.

Step 1
Create a new project for your web site and perform the initial search.

Step 2
Save your new project with the new search results to a project file. Give the file a name that 
indicates the date on which the search was run. For example, "mydomain12131998.dog".

Step 3
Make any of the necessary changes to your web site's home page and resubmit your web 
site to the search engines using TopDog's auto submit feature.

Step 4
At some predetermined interval, like say every two weeks, reload the project file and run 
the search again. TopDog will display any changes to your ranking that have happened over 
the past two weeks. You can also save this new search to a new project file, so you can 
have a history of how your site has changed over time.



Tracking Competitors

Some of the power of TopDog comes to play when comparing search results. You can make 
comparisons with your competition to see how your site stacks up against theirs.

Step 1
Create a new project for your competitor's web site and perform the search.

Step 2
Edit the URL Addresses field to match your web site.

Step 3
Run the search again. TopDog will now show you how you rank against your competitor.



My site is submitted. What's next?

Once you've submitted your web site to the search engines, you'll probably have a lot of 
followup work to do, which would be far too time-consuming without TopDog. We 
recommend that you use TopDog to monitor your placement on a monthly basis, and allow 
it to automatically resubmit your site as necessary. Use the interim time to make 
adjustments to the content of your pages to make them more search engine friendly, a 
process known as "search engine optimization." With steady attention and good content, 
you'll beat your competition in obtaining coveted high rankings for your pages. 

You should be aware that search engine work can be tedious, and that results are often slow 
to develop. With steady, monthly maintenance you should be able achieve measurable 
results over a period of six to nine months or so, perhaps less with a little luck. However, if 
you neglect your monthly maintenance you risk losing your work.

Most search engines take anywhere from two to eight weeks to process submission 
requests, so your site will typically not show up for some time. In fact, it's very common to 
take as long as nine months to achieve good placement on a significant number of search 
engines, which is why it's important to use an automated tool like TopDog to monitor your 
progress.

Don't be discouraged if your web site doesn't show up right away. If, after some time has 
passed, and your web site still hasn't shown up on some of the search engines, consider 
using doorway pages, adjusting your meta tags, or use other techniques. There are many 
services on the web that provide such design assistance, and you can find links to several 
useful tips and resources on the Resources Page of our web site.



How can I tell if my site is listed on a search engine?

To determine if your site is listed on a search engine, without knowing the keywords for 
which it is listed, do this:

Open a new project in TopDog. Enter the domain name of your web site (e.g., 
"yourdomain.com") in both the URL Addresses and Search Terms fields and click the Search 
All button. The engines which contain your address in their database will typically show up 
as number one rankings.



I've submitted serveral times, and my site is still not listed?

Consider updating your web site by adjusting use of meta tags, doorway pages, and page 
content. Usually there is a problem with one or more of the pages that your are submitting 
that's causing the search engines to avoid indexing it, or to index it for keywords other than 
what you expected. Be sure to read the Tips section of this document.

We've prepared a special report, "Web Site Strategies: Search Engine Ranking and 
Optimization", that you may find useful. It's filled with dozens of useful ideas, tips, and 
pointers to make your web site search engine friendly. To purchase the report for $19.95, 
visit our web site or call us at 800-775-1073 (678-442-1623 outside the U.S.).



Accessing the Internet

Proxies and Firewalls
If your computer is located on a network behind a firewall or proxy and TopDog is unable to 
access any search engine, contact your network administrator for the IP address and port 
number of your organization's proxy server. Once obtained, click the "Properties" button on 
the toolbar and enter the information in the "HTTP Proxy" tab of the "Search Options" dialog 
that appears.



Enabling Simple MAPI Client

For those users that do not have a Simple MAPI Client enabled on their computer, we offer 
the following help in enabling it. You need to be running Windows 95 or 98 and have 
Outlook express installed and be using Outlook Express as your default email program. If 
you are using a different program for your email, you will need to enable it as your default 
Simple MAPI client. See the documentation that came with your email software for help on 
doing this.

Enabling Outlook Express As Simple MAPI Client

1) From the Window's task bar, click the <Start> button. The Start menu will display.

2) Select from the Start menu Programs|Internet Explorer|Outlook Express, this 
will start Outlook Express.

3) You may get the following dialog if Outlook Express is not your default email program. 
Click <Yes> to continue.

4) From the Outlook Express main menu select Tools|Options..., the Options dialog will 
display.

5) On the General tab check the option Make Outlook Express my default Simple MAPI 
client, then click <OK>.



6) You will now need to restart your computer for the changes to take affect. The 
emailing features in TopDog will be enabled as soon as you restart your computer.

Enabling Netscape Messenger As Simple MAPI Client

1) From the Netscape main menu select Edit|Preferences..., the Preferences dialog will 
display.

2) In the option tree on the left, drill down to Mail & Groups and then to Mail Server. 
The Mail Server options will display to the right.

3) Click the <More Options...> button at the bottom of the page. The More Mail Server 
Preferences dialog will display.

4) Check the option Use Netscape Messenger from MAPI-based applications. This will 
enable Simple MAPI through Netscape.



Adjusting Performance

Excessive Timeouts
If you receive a lot of "timed out" status messages, you may need to increase the number 
of seconds allowed for a response from the search engines. You may also need to decrease 
the number of simultaneous searches that are performed. To make these adjustments, 
select the "Options" button on the toolbar (or use Search->Options on the menu bar), then 
select the "Performance" tab of the dialog.



Lost Authorization Code?

Have you lost your authorization code? Don't panic, we can help. There are several ways to 
recover a lost authorization code.

· Visit the Authorization Code Recovery page on our web site.

· Select Help|Purchase TopDog Products... and click on the link labeled "Lose your 
authorization code?".

· If your email address has changed since you registered TopDog, send a message to our 
support department at support@topdog2000.com with your full name, the email address 
you used to originally register your copy of TopDog, and the new email address you wish 
to use. We will update our records with the new information and email your authorization 
code back to you. A confirmation message will also be sent to the old email address for 
security.



Technical Support

Registered users of TopDog are eligible for one year of software upgrades and technical 
support via email.

If you have questions about TopDog, you may find the answer in our lists of Frequently 
Asked Questions (FAQ's) on our website at the following URL's:

        http://www.topdog2000.com/topdog/faq.html

        http://www.topdog2000.com/topdog/support/techfaq.html

Before seeking technical assistance, please be sure to read the Troubleshooting section. You 
may also find the answer to your question on the technical support area of our internet web 
site:

        http://www.topdog2000.com/topdog/support/

If you are unable to resolve the issue using the suggested methods, please feel free to 
contact our technical support department. All technical support is handled via email, and we 
make a concerted effort to respond to all messages in a timely manner. Please direct 
inquiries to:

        support@topdog2000.com

Another valuable resource are other users of the TopDog software. To facilitate 
communication among our users, we've created an email discussion list server. You can 
use it to post questions to the TopDog user community at large. Everyone subscribed to the 
list server will receive a copy of each email message sent to the list server email address. 
For automated information on joining the list, send a blank email message to:

        topdog-users@topdog2000.com

Web Traffic Maximizer users may contact Macmillan Computer Publishing technical 
support at:

        http://www.mcp.com/support/



Tips

There are generally three types of search engines on the web today:

Crawler/Spider Engines
Accept only your site's URL and automatically index each page and its contents. Examples 
include WebCrawler, Alta Vista, Lycos, and InfoSeek.

Categorized Engines 
Require you to browse their site and select one or more categories in which to place your 
URL and a brief description. Examples of this type include Yahoo, Snap, and LookSmart.

Keyword Engines 
Require you to enter your URL, descriptive keywords, and a brief description of your site or 
page. Examples of this type include SupportHelp and many industry-specific search engines.

Regardless of the search engine type, there are several important points you should 
consider when designing your site and when submitting it to the search engines.

1. Some search engines (such as WebCrawler) give more weight to titles than to body text 
in a document. Use a title that uniquely describes your page or site. Include this 
information in the <TITLE> tag of your HTML document. Don't use generic phrases such 
as "Home Page".

2. Put as much descriptive information as possible about your site in its main page (usually 
index.html). It doesn't have to be long, but be sure to be specific and include important 
keywords and phrases.

3. For search engines that require the selection of one or more listing categories (e.g., 
Yahoo), take some time to peruse their sites and familiarize yourself with the available 
categories. When choosing a category, be as specific as possible. You may need to "drill 
down" several levels to find a category appropriate for your listing.

4. Is your product/site commercial or non-commercial? Is it regional or national/global? 
Choose category hierarchies appropriately.




